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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.

This document was last updated: Thursday, August 23, 2012
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Business Service Management
Release Notes

This file provides information about Business ServiceManagement (BSM) 9.20.

What's New in This Release
To view a full list of new features and enhancements in BSM 9.20, select Help > What’s New in
BSM, or download theWhat's New document from the HP Software Product Manuals web site.

BSM Support Matrixes
BSM system requirements and support matrix information, including BSM server and database
support matrixes as well as support and compatibility data for BSM data collectors and other BSM
components, is now located in the separate BSM System Requirements and Support Matrix
document, located on the HP Software Product Manuals web site.

Information about supported integrations between BSM and other HP or third-party software is now
available on the HP Solutions and Integrations portal (requires HP Passport login). Every
integration listed includes a description of the integration, support matrix, and links to integration
configuration documentation.
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Installation Instructions
For complete instructions on installing this software, see the relevant documentation:

l New customers should follow the instructions in the BSM 9.20 Installation Guide.

l Existing customers upgrading from 8.x or 9.x should follow the instructions in the relevant BSM
9.20 UpgradeGuide:

n BSMUpgradeGuide - 8.0x to 9.2x

n BSMUpgradeGuide - 9.0x to 9.2x

n BSMUpgradeGuide - 9.1x to 9.2x

Themost updated versions of these documents are available from the HP Software Product
Manuals web site.

The following planning and deployment resources are also available from the HP Software Product
Manuals web site:

BSM 9.20 Planning Guides Package, which contains:

l Getting Started Guide

l Operations Manager i Concepts Guide

l Planning Guide

l Deployment and Capacity Planner

l System Requirements and Support Matrixes Guide

l DatabaseGuide

l What's New document

BSM 9.20 Deployment Guides Package, which contains:

l Release Notes

l DatabaseGuide

l Installation Guide

l UpgradeGuide - 8.0x to 9.2x

l UpgradeGuide - 9.0x to 9.2x

l UpgradeGuide - 9.1x to 9.2x

l Hardening Guide
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Notes and Limitations
Problems and limitations are identified with a Change Request number (QCCRxxxxxxxx). Use this
number when looking for more information about the problem on the HP Software Support web site
(http://www.hp.com/go/hpsoftwaresupport), or when communicating with your HP Support
representative.

To see themost updated status of limitations listed in this section, new limitations published after
version release, or generally to view a list of known problems for a specific product and/or version,
on the HP Software Support web site click the Self-solve tab, select Include related
subproducts, select product, version, and operating system, select only Known Problems in the
Document types area, and click Search. You can also search for a specific CR using the keyword
box at the top of the Self-solve page.

General and Deployment
Deployment and Capacity Planner (Capacity Calculator): The Deployment and Capacity
Planner is located on the HP Software Product Manuals site.

You use this Excel sheet to input information regarding the scope of your deployment (applications,
number of users, expected data) and the capacity calculator then calculates the required hardware
and determines the size of your deployment. You then use this information to determine your
hardware requirements and deployment configuration. You can upload the data from the capacity
calculator Excel sheet while running the Setup and Database Configuration Utility in the Server
Deployment page.

Authentication:BSM’s default authentication strategy is Lightweight Single Sign-On (LW-SSO).
When LW-SSO is enabled, youmust use a fully qualified domain name (FQDN) to access BSM.
This will enable integration among supported HP applications with a Single Sign-Onmanager, as
well as working with BSM RTSM. If you are not able to provide an FQDN, it is still possible to use
IP addresses for LW-SSO-trusted hosts. For details on working with IP addresses, see
“Authentication Strategies” in the Platform Administration guide.

Temporary Internet Files:When logging into BSM for the first time after upgrading, delete the
browser's temporary Internet files. This should be done on each browser that accesses BSM.

Skype Add-ons:An Internet Explorer exception error message is thrown inside BSM pages
(usually on login page or in MyBSM), indicating Operation aborted. To resolve this issue, remove
the Skype add-ons from your client. For further details, see
http://support.microsoft.com/default.aspx/kb/927917.
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Upgrade: Graph family and instance included in content packs are not upgraded
(QCCR1A138542)

Description: After staged upgrade with operating system change (for example, Windows source
system being upgraded to a staged Linux target system) graph families and instances are not
visible in the PerformanceGraphMappings and in the Content Manager UIs.

The data is upgraded and available, but due to a wrong path value, not visible in the UI.

Workaround: Please apply the first available patch to fix this problem.

Upgrade Wizard may hang when pressing Back in the OPR Database Settings dialog
(QCCR1A142249)

Description: The UpgradeWizardmay hang when pressing the Back button in the OPR Database
Settings dialog.

Workaround:Stop the UpgradeWizard and restart it. Using the Next button, progress to the dialog
that you want to edit and continue with the upgrade.

Configuration continues after fatal error and skips further important configuration steps
(QCCR1A144758)

Description: In very rare occasions, during the running of the ConfigurationWizard, the step that
copies the data of customer 0 to customer 1 fails. A fatal error message is displayed but theNext
button is active. If you click Next, the flow jumps to opr-db-end and skips the remainder of the
opr-related configuration, and then continues with the overall flow. This results in a corrupt
installation. Problems include strange behavior of Event Browser with errors on refresh, no
certificates onGateway Servers, each Data Processing Server only has it's own certificates and so
are different from each other.

Workaround: If a fatal error is displayed, do not continue with the configuration. Stop the
ConfigurationWizard and resolve the reason of the fatal error before restarting the Configuration
Wizard.

Gateway Servers do not get their node certificate automatically assigned (QCCR1A146503)

Description:When adding additional Gateway Servers in a distributed environments with multiple
Data Processing Servers, it is possible that the new Gateway Servers do not get their node
certificate automatically assigned.

Workaround: To assign node certificates to a newly addedGateway Server, complete the
following steps:

1. On theGateway Server system, enter the command:

ovcert -certrequest
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2. In Admin UI open the Certificate request Browser:

Admin > Operations Management > Setup > Certificate Requests > Certificate
Requests

3. In the Certificate Requests tab, select the associated certificate request and select Grant
Item from the context menu.

Events from data collectors are buffered and the OVC process is not running
(QCCR1A146584)

Description: All events from data collectors, such as SiteScope, and HPOM, are being buffered
and no events are being processed by BSM. TheOVC process is not running.

Workaround: If you reboot a Gateway Server, make sure the OV processes are running. To start
these processes, enter the following command appropriate for your Gateway Server installation:

l Windows: %OvInstallDir%\ovc -start

l Linux: /opt/OV/bin/ovc -start

CI Resolver initialization is blocked if CI label is too long (QCCR1A146666)

Description: Startup of the opr-backend processes are blocked if the following is true:

l Cache typeDatabase is selected (default).

l Label of one or more CI is larger than 255 characters.

In addition, event processingmay be blocked after a successful startup of opr-backend processes
if a full cache reload takes place.

Workaround: Reduce the length of long CI labels.

Alternatively, change the cache type to In Memory.

9.20 UCMDB Packages are not available after upgrade (QCCR1A146975)

Description: After upgrade from version 9.13 to version 9.20, the UCMDB Packages for the 9.20
version are not available.

Workaround: On the Data Processing Server system, run the commands appropriate for your
operating system:

Unix:

touch /opt/HP/BSM/odb/conf/factory_packages/content

$TOPAZ_HOME/opr/support/opr-jmxClient.sh –s localhost:29622 –u
<JMXusername> -p <JMXpassword> -b opr.ucmdb:name=UcmdbConnectionMBean
–m upload –a 1

Windows:

copy /b C:\HPBSM\odb\conf\factory_packages\content\* +,,
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%TOPAZ_HOME%/opr/support/opr-jmxClient.bat –s localhost:29622 –u
<JMXusername> -p <JMXpassword> -b opr.ucmdb:name=UcmdbConnectionMBean
–m upload –a 1

Customized version of httpd-ssl.conf file might be overwritten. (QCCR1I41178)

Description: If BSM is configured for secure access (using Apache + SSL), BSM uses a
customized version of the file httpd-ssl.conf. This file might be overwritten during the upgrade
with a standard version of the file, breaking the configuration.

Workaround:Before upgrading, backup the customized file <HP BSM root
directory>\WebServer\conf\extra\httpd-ssl.conf. Then reapply the changes to
httpd-ssl.conf using the backup version as a reference to the location of the certificate files.

Applets fail with an unexpected handshake message (QCCR1I44883)

Description: In environments in which the BSM server requires a client certificate, applets using
Java 1.6.0_20may fail with an unexpected handshakemessage. This is a known issue from Sun
(Oracle).

Workaround: Add the parameter -
Dsun.security.ssl.allowUnsafeRenegotiation=true to the Java client.

Multiple prompts to enter credentials (QCCR1I45194)

Description:When using Java version 1.6.19 and higher in a secure environment (SSL) using
basic authentication, you are prompted to enter credentials for each applet every time the applet is
loaded. This is a known issue by Sun (Oracle). 

Workaround: As suggested by Sun (Oracle): When each applet loads the first time, select
Remember password. There is no security concern with this workaround since the applets are
also protected by the browser and you are prompted for your credentials once every time you log
into BSM through the browser using basic authentication.

High Availability Controller cannot move services (QCCR1I46345)

Description: If there is a problem with one of themarble_* processes (for example, one of the
processes cannot start), youmust disable themarble_supervisor process. If this process is not
disabled, the High Availability Controller (HAC) cannot move the process’ services (such as the
DASHBOARD service that controls Service Health) to another Data Processing Server if there is a
problem with the primary server.

Workaround: Disable themarble_supervisor process. HAC will move DASHBOARD service to
another DPS.

Restart of BSM may be required after database outage (QCCR1I46504)
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Description: If themanagement database was down or unreachable and the connection has been
restored, youmay have to restart BSM.

Workaround: Restart BSM when themanagement database is available again.

Adding additional Gateway servers with differing paths causes login failures
(QCCR1I47337)

Description: If twoGateway servers are installed onto different drive paths, for example, one was
installed onto the C:\ drive and the other onto the E:\ drive, BSMmay not be able to be accessed.

Workaround: Create a duplicate path on the C:\ drive by copying E:\<HP BSM root
directory>\conf\settings to C:\<HP BSM root directory>\conf\settings.

Upgrade will fail if IDM-SSO is enabled in the source environment. (QCCR1I58648)

Description: If you are using IDM-SSO, upgrade will fail if IDM-SSO is enabled in the source
environment but not yet configured in the target environment.

Workaround: Disable IDM-SSO on the BSMGateway Server before running the configuration
upgrade in the target environment. To do so:

1. Log into the JMX console (http://<Gateway Server name>:8080/jmx-console) and search for
the SSO service (service=SSO).

2. Locate the setSingleSignOnMode operation and in the ParamValue box, type Lightweight.

3. Click Invoke.

IDM-SSO can be re-enabled after BSM 9.10 is up and running from within BSM (Admin > Users
and Permissions > Authentication Management wizard).

View Size (QCCR1I61961)

Description: To enhance performance, in BSM 9.10 there is a view-size limit. As a result, if you
created an extremely large view in BAC 8.x, the view may not be supported by the RTSM in 9.10 or
later.

Workaround:Contact HP Support for assistance in creating new views to suit your needs.

Staging Data Replicator (SDR) issues (QCCR1I63137)

l The procedure for unsubscribing the SDR on a standalone Linux deployment should use the
following scripts rather than the Nanny JMX console:

/opt/HP/BsmSDR/scripts/run_hpbsmsdr.sh start/stop

l Nanny manager JMX console will not show the correct SDR process status.
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Automatic BSM content pack upload may fail after upgrade if
SISConfigurationEnrichmentUpgrader fails (QCCR1I65695)

Description:During BSM upgrade, if theSISConfigurationEnrichmentUpgrader reports
FAILED, PARTIALLY FAILED, or NOT REQUIRED status, the BSM content packs may not
automatically upload upon restart.

Workaround: Delete the blockAutoUpload file located in the <HPBSM root
directory>\conf\opr\content folder afterSISConfigurationEnrichmentUpgrader finished and
before BSM restart.

Platform
Authentication:WhenHP Business ServiceManagement is installed with anOracle Database
and User Synchronization enabled with an LDAP Active Directory server, ensure that you login to
HP Business ServiceManagement with the correct-case UID (uppercase or lowercase), as
configured on the LDAP server. This is because while the Oracle Database is case-sensitive, the
LDAP Active Directory is not case sensitive, and logging in with an incorrect case UID can create
undesirable results.

For example, if a user called testuser exists on the LDAP Active Directory server and logs into HP
Business ServiceManagement, he is automatically created as HP Business ServiceManagement
user testuser, who can be assigned permissions in the HP Business ServiceManagement User
Management interface. If you then login to HP Business ServiceManagement as Testuser, the
LDAP Active Directory server sends an acknowledgement that the user exists (because Active
Directory is not case sensitive) and he is allowed entry to HP Business ServiceManagement.
However, since the Oracle Database does not identify this user as testuser (because theOracle
Database is case sensitive), the user Testuser is treated as a new user, without the permissions
that were assigned to testuser.

NLS_LENGTH_SEMANTICS: The recommended setting for Oracle parameter NLS_LENGTH_
SEMANTICS is the default setting of BYTE; setting this value to CHAR may affect database
performance.

Infrastructure Settings: Changes to infrastructure settings are not included in the Audit Log.

Schema Creation: You cannot create a schema that starts with a digit.

Downtime notifications may not be sent if the Data Processing Server is down
(QCCR1I44964)

Description: If the Data Processing Server is down for any reason, notifications of downtime
starting and ending during the time period when the Data Processing Server was downmay not
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ever be sent. Notifications sent to recipients regarding downtimes are configured during downtime
creation.

Workaround: None.

Adobe Flash plugin errors in Firefox 3.6.4 or above (QCCR1I55463)

Description:Whenworking with BSM in Firefox 3.6.4 or above, Firefox may display one of the
following error messages:

l The Adobe Flash plugin has crashed.

l Adobe Flash Player <version>. An ActionScript error has occurred. Error #1502: A script has
executed for longer than the default timeout period of 15 seconds.

This is due to a known problem with the browser’s "out-of-process plugins" (OOPP) crash
protection feature (for details, see https://bugzilla.mozilla.org/show_bug.cgi?id=574905).

Workaround: To prevent this behavior, go to about:config and set all dom.ipc.plugins.enabled.*
preferences to false. This prevents the "plugin-container" process from running, and all plugins will
run within the Firefox browser process. For details, see http://kb.mozillazine.org/Plugin-container_
and_out-of-process_plugins#Disabling_crash_protection.

Java applets may fail to load (QCCR1I57396)

Description: Java applets may fail to load intermittently.

Workaround: If a Java applet in BSM fails to load, clear your Java client cache:

1. In theWindows Control Panel, click Java.

2. On theGeneral tab, select Settings > Delete Files.

Firefox 3.6.14 is not supported (QCCRI58176).

Description: Due to a problem with applets in Firefox 3.6.14, BSM 9.10 does not work properly in
this environment.

Workaround: Do not use BSMwith Firefox 3.6.14. This specific version of Firefox fails to load
applets. The problem does not occur in other versions of Firefox (for example version 3.6.15).

Applets fail to load when  "Internet Explorer Enhanced Security" is enabled
(QCCR1I59140)

Description: In some environments, certain applets fail to load when Internet Explorer
Enhanced Security is enabled on the client machine (for example, the LDAP Group Mapping
Wizard).

Workaround: Disable Internet Explorer Enhanced Security on the client machine (for example,
Control Panel > Add/Remove Programs > Add/RemoveWindows Components > scroll down to
Internet Explorer Enhanced Security Configuration and uncheck the box).
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Login page does not load if accessing through LB in separate domain from BSM
(QCCR1I60724)

Description: When connecting to BSM using an FQDN, you still see the following error in the login
screen: The HP Business ServiceManagement URLmust include the Fully Qualified Domain
Name (FQDN).

Workaround:Retype the HP Business ServiceManagement URL in the address bar, and check if
there is a DNS resolution for Load Balanced virtual IPs from the BSM gateways.

Graphing
Virtualization_Infrastructure view in Performance Perspective: Performance graph does not
display for VM hosted on ESX machine (QCCR1A114189)

Description: For the Virtualization_Infrastructure view in the Performance Perspective,
performance graphs are not drawn for virtual machines hosted on an ESX server.

Workaround: In themodel explorer, select the vMA node first and then select the VM that you are
interested in. The performance graphs are drawn as expected.

When launching performance graphs (CI) from a VMware event, the graphs show metrics
for VMs with similar names (QCCR1A118759)

Description:When a user launches a graph for a Virtual Machine CI, graphs are drawn for all the
virtual machine CIs that have similar names.

Workaround: Close the graphs for unwanted virtual machine CIs.

Unable to delete custom graphs in Operations Management in Internet Explorer 8
(QCCR1A119284)

Description: It is not possible to delete custom graphs throughAdmin > Operations
Management in Internet Explorer 8.

Workaround: Log out and then log in again to see the changes. The selected custom graphs are
deleted.

Launching of Performance Graphs (neighborhood) option for virtualization configuration
items (CIs) takes a long time to respond (QCCR1A123200)

Description: Launching of PerformanceGraphs (neighborhood) for virtualization configuration
items (CI) takes longer if there are no agents running on the neighborhood nodes. This delay
happens because the performance graphs try to connect to each of the nodes with a default time-
out of 60 seconds per node.
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Workaround: Use either of the following workarounds:

l Use the Launch PerformanceGraphs (CI) option from the Event Browser for viewing the
virtualization related CIs.

l You can also change the default time-out required by Graphing to connect to the nodes.

To change the default time-out to connect to the nodes follow these steps:

a. Launch a web browser and then enter the following URL:

http://<Gateway or Data Processing server name>:8080/jmx-console/

TheGateway or Data Processing server name is the name of themachine on which HP
Business ServiceManagement is running.

b. To login into JMX Console, you are required to enter the authentication credentials
configured when installing BSM and running the Setup and Database Configuration utility.

c. Click service=Infrastructure Settings Manager under Foundations to open the JMX
MBEAN View page. In the void setGlobalSettingValue(), enter the values opr,
opr.graphing.responsetimeouthttp and <new timeout value> (in seconds) in
theParamValue field for the parameters listed.

EUM - event launch shows all instances with same name (QCCR1A120394)

Description:When a user launches graphs for an EUMCI in one Business Transaction Flow
(BTF) from the Event Perspective, graphs are displayed for all the CIs having similar names in other
BTFs as well.

Workaround: After the graphs are drawn, expand the left pane in the graph window and select only
the CI for which you want to view the graphs. Graphs for selected CI are then drawn.

Trying to save a custom graph gives an error message. (QCCR1A126044)

Description:When you try to save a custom graph, the system shows amessage stating that an
error occurred while saving the graph. This is due to failure of the graph association.

Workaround: A user with Administrator privileges must manually associate the saved graph.

Line series in the graph for different intervals do not appear even though the points are
plotted (QCCR1A131613)

Description: For different data sources, the line series in the graph for different intervals do not
appear at times, though the points are plotted. This is because the series is in different time
intervals.

Workaround: Formetrics for data sources, draw separate graphs.

Pre-defined graphs for HP Operations Smart Plug-ins (SPI) are not coming up in
Performance Perspective.(QCCR1A139847)
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Description: If you are using HP Performance Agent (PA) tomonitor your SPI, the pre-defined
graphs do not come up. This is because PA does not support multi-instance data logging. But if you
are using CODA, you can draw the pre-defined graphs.

Workaround: None.

Predefined graphs are not listed when NIC is selected.(QCCR1A143377)

Description:When you select theMAC address of an NIC as a CI from theModel Explorer, the
corresponding predefined graphs are not listed. This is because while creating the Performance
GraphMappings, the NIC name is mapped to the predefined graphs and not theMAC address.

Workaround: Select the corresponding host to view the predefined graphs.

Graph for vSphere Management Assistant (vMA) is drawn when guest system is selected
(QCCR1A143487)

Description:When a System PerformanceGraph (for example: Global History) is selected, a
graph for a vMA node is drawn instead of the guest system. This is because, when an agent is
installed on a vMA and both the vMA and an agent aremonitoring a CI, PerformanceGraphing
draws the graph for the first data source returned. If the first data source returned is that of vMA, the
graph for vMA is drawn. Instead of drawing graph for themonitored CI, the system draws the graph
for the vMA node.

Workaround: Select the agent data source from the Data Sources box in theMetrics tab and draw
the graphs.

In the Metric Selection Window of the Design Wizard, the system displays only the last
selected data source in the Data Sources list. (QCCR1A143696)

Description: In theMetric SelectionWindow of the DesignWizard, the system displays only the
last selected data source in the Data Sources list.

Workaround: None.

Error when selecting multiple nodes for a CI from the Model Explorer (QCCR1A144078)

Description: If you select more than one CI, the system displays an error stating that a related
data source could not be found.

Workaround: In PerformanceGraphing, select only one CI from the tree view to draw graphs.

Data not available for some monitors for new SiteScope monitors (QCCR1A145635)

Description:When you create a SiteScopemonitor, data is not available for somemonitors such
as, URL and Logmonitors.
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Workaround: The data will be available after a few hours. If you want the data to be shown
immediately in BSM, restart the BSM services.

Integrations
NNMi Integration:Configuring topology integration between NNMi and BSM requires the
configuration of credentials to log into the RTSM. You define RTSM users in the UCMDB Admin
application, not in BSM itself. To configure an NNMi integration user, go to http://<BSM_
server>:21212/ucmdb-ui/applet/applet.jsp, and then selectManagers >
Administration > Users and Roles. Define the name and password of an integration user.

For NNMi, the user at minimum needs to have the following roles:

l CmdbOpenApiImpact

l CmdbOpenApiQuery

l CmdbOpenApiUpdate

The default credentials are admin/admin.

Release Control (RC) Integration: If you are integrating BSM with Release Control (RC) 9.11 or
earlier, perform the following procedure to solve an issue that prevents correct integration of RC
Change Requests into the Changes and Incidents tab in Service Health.

1. Navigate to the Adapter Management page and in the Resources pane select
RcChangeAdapter > Configuration Files > convertFields.properties.

2. Append the following line to the end of the file: urgency=urgency

3. Create a new properties file called RcChangeAdapter/urgency.properties and add the
following lines:

n # File format:

n # RC urgency value=uCMDB urgency value

n Critical=1_critical

n High=2_high

n Normal=3_average

n Low=4_low

n #UNKNOWN= there is no available value in uCMDB: 'it_process_
urgency_enum'

4. Save the file.

If the integration does not work after following the above procedure, contact HP Customer Support.
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HPOM Integration:More than one HPOM (formerly HP OVO)monitor can be created on the same
port using the Copy function, resulting in duplicate HPOM events. In such cases, delete the copied
monitor. Note that the HPOM Event monitor is not available when SiteScope 11.x is connected to
BSM 9.x, unless themonitor was created in an earlier version of SiteScope that was upgraded to
SiteScope 11.x.

EMS Integration:

l Themaximum size of an expression in the EMS Integration configuration file is 4000 characters.

l An EMS monitor may not find its configuration file when upgrading the SiteScope version. In
such cases, manually copy the contents of the configuration file to the EMS monitor
configuration in the user interface.

In the BSM-Diagnostics integration (Admin>Diagnostics) an error occurs on short-name
and there is no way to re-enter the FQDN (QCCR1I62229)

Description:You should use the FQDN when registering the Diagnostics Server with BSM.
However if you entered a non-FQDN for the Diagnostics Server you could get stuck in a registration
problem loop.

Workaround:Use the URL below and substitute the “topazhost” name in the URLwith the FQDN
of the BSM 9.1x Gateway Server to clear the Diagnostics Configuration page in BSM:

http://topazhost/opal/uibridge/action/registration.do?action=set_
registration&customer_name=Default%20Client&opal_protocol=&opal_
port=&opal_full_host=

Reports and Reporting
PDF: It is not possible to search charts inside reports exported to PDF (since the charts are saved
as images). It is possible to search inside tables.

Export: It is not possible to export chart reports to Excel and XML (CSV is supported).

TransactionVision is missing from the Service Report data sources (QCCR1I45415)

Description: The TransactionVision data is not supported as a data source in Service Reports in
BSM.

Workaround: None.
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Service Health
Administration

Rules API Examples: The Rules API that was introduced in Business Availability Center version
8.00 enables you to create new business rules for Service Health and Service Level Management,
using the Groovy scripting language. The BSM documentation contains basic examples of API
rules. Additional examples of rules based on customer requests can be found in the Self-Solve
knowledge base, in document KM778069. This document is intended to be collaborative, andmore
API rules will be added to it based on customer input. If you have any comments on existing rules or
suggestions for new rules, please provide feedback on the document within the knowledge base.
Your feedback will then be included within the document.

Modifying an HI from being fed by metrics to being fed by events (QCCR1I42865)

Description: In general, when youmanually edit an HI on a CI using the CI Indicators tab (for
example to use a different calculation rule), the assignment mechanism does not override these
changes. However, if youmodify an HI from being fed by metrics to being fed by events, the
assignment mechanism does not recognize this change, and the HI is restored to its original
setting. This scenario is not likely in typical usage of BSM.

Workaround: None.

Changing the breakdown configuration does not refresh Service Health components
(QCCR1I46143)

Description: In the BreakdownUI, changing the breakdown configuration does not refresh Service
Health components.

Workaround: If you have configured a breakdown in a local impact view (for example, transaction
by location), and you want to change the breakdown type (for example, to location by transaction),
youmust perform the below steps:

1. Edit the original breakdown configuration, and select the new breakdown type as None.

2. Save the change, and wait a few minutes for the change to take effect.

3. Select your view, and edit the breakdown type to the type you want defined.

Changes made to triplets not reflected in Service Health calculation (QCCR1I59377F)

Description: If youmake changes to the triplets that define impact links withinRTSM CI Type
Manager > Calculated Relationships > Triplets, these changes are not reflected in Service
Health calculation.

Workaround: After making these changes, access the JMX console (http://<server
name>:21212/jmx-console). Within theUCMDB list of services, select TQL Services, and
invoke retrieveTqlNames using your customer ID. Within the results, search formarble_

HP Business ServiceManagement (9.20)Page 21 of 58

Release Notes
Notes and Limitations



dashboard_tql, and click Deactivate. When deactivation is done, click Activate. Service Health
calculations will now implement your modified impact links.

Hidden rule parameters lose their default values (QCCR1I65242)

Description: If you create a KPI assignment that uses a rule with hidden rule parameters, and the
assignment updates an existing KPI with a different rule, the hidden rule parameters lose their
default values. This typically impacts rule calculations. (Note that this does not apply to new KPIs,
but only to existing KPIs which had a different rule before they were updated by the assignment.)

Workaround: Before updating the assignment, edit the rule definition in the Rule Repository and
make the hidden rule parameters configurable (not hidden). You can then update the rule in the KPI
assignment, and synch existing CIs. After you save the assignment, you can return the rule
parameters to be hidden. Alternatively, you can delete the existing KPIs before running the KPI
assignment; this causes the assignment to create the KPIs rather than update them.

Cannot create local impact pattern view based on the BSMDowntime_impact query
(QCCR1I65385)

Description:WithinService Health Administration > View Builder, you cannot create a local
impact pattern view based on theBSMDowntime_impact query.

Workaround: You can create a pattern view based on theBSMDowntime_impact query within
RTSM Administration > Modeling Studio.

Changes to breakdowns may result in inconsistent KPI statuses (QCCR1I70973)

Description: If youmake changes to a breakdown that impact KPI or HI status (for example if you
change the KPI calculation rule from worst to best child), theremay be inconsistencies between the
statuses in the Service Health UI and other components such as reports.

Workaround: None.

Application
TheWatch List component in Service Health does not support breakdowns; you cannot add virtual
CIs (breakdownCIs) from a local impact view to a watch list.

PNR KPI Persistency: The PNR KPI in Service Health does not have persistency in case of a
Data Processing Server failure or a system restart. The PNR KPI shows an initialized status until
the SLA is recalculated, at which time the PNR value is updated.

Daylight Savings Time:
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l Reports that include the time period during which a Daylight Savings Time (DST) change took
place (change to or change from DST) will either bemissing one hour (in cases where clocks are
moved forward) or have two sets of data for the same hour (in cases where clocks aremoved
back).

l If a report’s time range includes the time of a Daylight Savings Time (DST) change, the data for
the period after the DST time change is incorrect. To obtain correct data for the entire time range,
print two separate reports, one for the time range before the DST time change and one for the
time range after the DST time change.

Moving the Configuration Items dialog box can freeze the UI (QCCR1I42825)

Description:Within the 360° View, if you select the Filter icon on the toolbar, and then click the
Configuration Items link, the Configuration Items dialog box opens. If youmove this dialog box
within the screen, the UI can freeze.

Workaround: Reselect the component to enable it again.

If the management database goes down, the 360° View suffers a fatal error (QCCR1I46512)

Description: If you are working with High Availability and a load balancer, if themanagement
database goes down, the 360° View suffers a fatal error.

Workaround: Log out of BSM and then log in again.

Inconsistency displaying breakdown views (QCCR1I47502)

Description: If no new samples were received after a breakdownwas defined in a view, and
samples were received from only some of the locations, the view can show inconsistent worst
statuses on the locations.

Workaround: None.

Inconsistency in breakdown view for KPIs that do not participate in the breakdown
(QCCR1I47561)

Description: In a local impact view with breakdown defined, when a KPI is based on samples that
do not contain the relevant breakdown information, the KPI may contain misleading data. For
example, youmay have a breakdown of location by application, and an application CI shows Worst
Status of the System KPI from two business transactions. If these BTs are in two locations, and
the KPI is Critical in one of the two, each location will show the application as Critical, even though
the BT is Critical in only one of the locations.

Workaround: None.

Not possibile to reset HI to default (QCCR1I48559)
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Description: In the Health Indicators component, themenu command "Reset Health Indicator" to
reset an HI to its default state does not work for metric-based indicators.

Workaround: None.

In the Health Indicator component, if an event has arrived twice, there is no tooltip for the
related HI (QCCR1I66891)

Description: AnHI in the Health Indicator component has no tooltip. Investigation shows this is
because the HI is related to an event that has arrived twice to BSM.

Workaround: None.

Hierarchy
Only one filter is saved in session per user and customer (QCCR1I52699)

Description:Within the Hierarchy component, only one filter can be used at a time, per user, per
customer (regardless of quick filter or advanced). This means that if a user is using a filter in one
Hierarchy component, and the user then activates a different filter in another Hierarchy component,
the first filter is overridden.

Workaround: None.

Filter change done during Web Server or Application Server restart is not saved
(QCCR1I62605)

Description: If you are working in a high availability environment with a load balancer, and are
editing an existing filter in Service Health when the web server or application server restarts,
changes to the filter are not saved.

Workaround:None.

MyBSM
JavaScript errors when navigating from MyBSM (QCCR1I47291)

Description: In some versions of Internet Explorer if the browser is configured to show JavaScript
errors, when you navigate fromMyBSM to a different application in BSM, a popup window appears.
This window contains the followingmessage: Errors on this webpage might cause it to work
incorrectly.

This message is not indicative of a problem. Any changes youmade inMyBSM are saved, and
MyBSM continues to work correctly.

Workaround: To prevent this message from appearing, within Internet Explorer access the
Internet Options > Advanced tab, and clear theDisplay a notification about every script error
checkbox.
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Wiring to the NNMi Path View component does not work (QCCR1I47619)

Description:Wiring to the NNMi Path View component does not work. For example, if Top View
and Path View are on the same page, when you select a CI in Top View, the Path View component
does not show the path for this CI in NNM topology.

Workaround: None.

Service Level Management
Rules API: The Rules API that was introduced in Business Availability Center version 8.00
enables you to create new business rules for Service health and Service Level Management, using
the Groovy scripting language. The BSM documentation contains basic examples of API rules.
Additional examples of rules based on customer requests can be found in the Self-Solve knowledge
base, in document KM778069. This document is intended to be collaborative, andmore API rules
will be added to it based on customer input. If you have any comments on existing rules or
suggestions for new rules, please provide feedback on the document within the knowledge base.
Your feedback will then be included within the document.

PNR KPIs:In Service Level Management, you cannot attachmore than one PNR KPI (defined in
Service Health) to a CI.

CIs in SLAs:You cannot add a CI to an SLA when the CI includes a copy of itself in the original
definition in the RTSM. This is because nesting is meaningless in the SLA calculation (Service
Level Management cannot calculate a CI using the CI result as a value). If you do so, your
operation will fail with a general error. However, you can add the sameCI to an SLA more than once
if the CI does not include a descendant of itself. In this case, Service Level Management calculates
the CI only once, so the objectives are the same nomatter where the CI appears in the SLA
hierarchy.

Linkage between Business Transaction and SAP Transaction is disabled (QCCR1I47274)

Description: After BSM restart, the automatic linkage of Business Transactions to SAP
Transactions is disabled.

Workaround: To enable the linkagemechanism, restart the VERTICALS service in the
MercuryAS process.
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Operations Manager i
Authorization

Deleted users and groups remain visible in the Event Perspective (QCCR1A91299)

Description:When user groups are added or deleted, the change is not immediately visible in the
User Assignment dialog of the Event Browser or Event Details.

Workaround: After the refresh interval of 10minutes, log off and back on again. The deleted users
and groups will not appear and any added users and groups should be available.

Content Packs
Non-customized Correlation Rules have Artifact Origin set to Predefined (Customized)
(QCCR1A144396)

Description: After upgrading from BSM 9.13 to 9.20 someCorrelation Rules from the following
Content Packs have the Artifact Origin labeled as Predefined (Customized) even though
those artifacts have not been customized:

Infrastructure (9.20), J2EE (9.20), Microsoft Active Directory (9.20), Microsoft Exchange Server
(9.20), Microsoft Lync Server (9.20), Microsoft SQL Server (9.20), Oracle (9.20).

The Artifact Origin of the contents in the factory Content packs should be Predefined after
upgrade if they were not modified by user before upgrade.

Workaround: You can use theRestore to Default feature to reset incorrectly labeled correlation
rules to reflect the 9.20 version.

Configuration
Some Operations Management user interfaces do not open on Korean, Japanese, and
Simplified Chinese systems (QCCR1A147195)

Description: Some parts of the Operations Management user interface do not open when the
Internet Explorer language preferences include Korean (ko-KR), Japanese (ja-JP), and Simplified
Chinese (zh-CN).

Workaround: Contact HP Support to receive a hotfix for the problem. In themeantime, remove
Korean, Japanese, and Simplified Chinese from your Internet Explorer language preferences.

Content Packs: Exchange
ETIs are not resolved for Exchange servers on clusters using HP Data Flow Management
or Dynamic Topology Synchronization (QCCR1A108412)
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Description: If Exchange Servers hosted on clusters are discovered with HP Data Flow
Management or Dynamic Topology Synchronization, then the events from the Smart Plug-in for
Exchange do not impact the Exchange Server CI type in the cluster.

Workaround: None.

Content Packs: Infrastructure
Events from the policy "SI-NetworkUsageAndPerformance" may fail to map to the correct
CI (QCCR1A130703)

Description:On a node that has multiple network interfaces, events from the policy "SI-
NetworkUsageAndPerformance" fail to map to the correct CI.

Workaround:None.

Content Packs: J2EE
Import of J2EE Content Pack fails on German and Russian locales (QCCR1A146834)

Description: Import of J2EE Content Pack fails on systems with German or Russian locales.

Workaround: Do not useGerman or Russian localized Content Packs. Use the English version of
the Content Pack instead.

Alternatively trim the following labels andmake sure that the labels do not exceed 255 characters:

l ID = 09c0a044-62e7-41e3-b20a-d89f24ffafdb : Label="J2EE::J2EE Server:DataSource
ConnectionPool Utilization >> Transaction Capacity Utilization & JDBC Connection Pool Wait
Count & Transaction Time & Transaction Commit Rate & Transaction Start Rate & DataSource
Connection Pool Availability"

l ID = 5f5d025e-957f-4a1c-b1f1-f460ba4f632b : Label="J2EE::J2EE
Server:ThreadPoolUtilization >>ExecuteQueueWaitCount & ActiveSocketsCount &
ServletPerformance & DeferredThreadRequests & ThreadRequestWaitTime &
ThreadRequestsPending & ThreadRequestServiceTime & ThreadPoolAvailability &
JVMMemoryUtilization"

l ID = b1731cea-142e-45bc-8d80-86cf6c381223 : Label="J2EE::JDBC Data Source:DataSource
ConnectionPool Utilization >>Transaction Capacity Utilization & JDBC Connection Pool Wait
Count & Transaction Time & Transaction Commit Rate & Transaction Start Rate & DataSource
Connection Pool Availability"

l ID = ee95db49-f58e-4c62-b8f9-b8925970ab1b : Label="J2EE::J2EE Application:Servlet
Requests >>Thread Pool Utilization & Active Sockets Count & JVMMemory Utilization &
HTTP Sessions & Thread Requests Pending & Servlets Loaded & Interface Discard Rate &
Interface Utilization
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Event Browser
Not all areas can be controlled using only the keyboard (QCCR1A4280)

Description: It is generally possible to control the Operations Management user interface using
keyboard navigation. In some cases, however, a pointing device of some kind is required. For
example, when an event is selected in the browser using the keyboard (arrow keys + space) the
event details are updated, but the event is not delivered to other portions of the user interface. Other
examples include switching between tabs and activating context menus.

Workaround: Use a pointing device when keyboard navigation is not possible or does not function
correctly.

Ctrl+A does not select all events in the event browser (QCCR1A135812)

Description: PressingCtrl+A does not select all events in IE8 and Firefox.

Workaround: Press Home and then press Shift+End to select all rows.

Alternatively, useSelect all from the Context Menu.

Stream-Based Correlation
Events processing stops when using SBEC Missing Recurrence rules with Discard Events
option (QCCR1A146588)

Description: Using an SBEC Missing Recurrence rule with the Discard Events option stops
the event pipeline as soon as the rule triggers. No further events can be processed, until the opr-
backend process is killed and restarted. SBEC Missing Recurrence rules without the Discard
Events option work as expected.

Workaround: Do not use Discard Events in any Missing Recurrence rules.

If you have SBEC Missing Recurrence rules with the Discard Events option, change the option
toClose Events and restart the opr-backend process as follows:

1. Change all existing SBEC Missing Recurrence rules with the Discard Events option to use
Close Events option.

2. Restart opr-backend by terminating the hpbsm_opr-backend process using one of the
followingmethods:

a. Restart BSM on each Data Processing Server. This may take some time.

b. Manually terminate the hpbsm_opr-backend process. It will be automatically restarted.

Caution: Events being held by Stream-based Correlation will be lost.
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End User Management
BPM and RUM Advanced with SLM licenses are not valid (QCCR1I56279)

Description: BPM andRUM Advanced with SLM licenses are not valid in BSM 9.10 or 9.12. If you
upgraded from a BSM 9.0x version in which you were using evaluation versions of such licenses,
they will show as expired. RUM probes assigned an expired license will not monitor any application
tiers. BPM applications assigned an expired license will still bemonitored, but will have limited
configuration options.

Workaround: Install and assign valid licenses.

Drilldown menu working incorrectly in reports with a tree table in Internet Explorer 9
(QCCR1I69035)

Description: When using IE 9 to view EUM reports that include a tree table, the right-click Shortcut
menu for drilldowns does not always work.

Workaround: View the reports using the IE compatibility mode.

Business Process Monitor
VuGen Scripts:When you run a script written in VuGen that uses proxy settings from an automatic
configuration script (.pac file) configured in the run-time settings of the script, if one of the proxies in
the .pac file is unavailable, replaying the script in either VuGen or Business Process Monitor may
result in a high response time and, in some instances, the script may fail due to a timeout. The
script can be run in Internet Explorer without this problem, as it ignores the unavailable proxy.

BSM URL: Business Process Monitor registers with BSM using http://<BSM Gateway
Server name>/topaz, and not with HPBAC orMercuryAM at the end of the URL. Youmust use
this format when creating instances for Business Process Monitor.

Page Component Breakdown URL:When running a page component breakdown (from EndUser
Management or Business Process Monitor), the target URL is limited to 144 characters.

Usage of BSM 9.x Script parameter feature: Script parameterization is supported for BPM
version 8.x and later. (QCCR1I65877)

BPM instances on Windows

Description: Youmust run BPM instances onWindows 7 as a system user (default) or as a user
with administrator privileges.

Workaround: None.
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WebTraces over UDP protocols do not work (QCCR1I56114)

Description:WebTraces configured to work over UDP protocols do not work inWindows 7 and
Windows 2008.

Workaround: None.

Default granularity of the BPM Custom Reports time filter is calculated differently
(QCCR1I60312)

Description: The default granularity of the BPM Custom Reports time filter is calculated differently
in BAC 8.x and BSM 9.x. Thus, BPM Custom Reports created in 8.x may appear differently after
being upgraded to 9.x.

Workaround:Edit the filter in 9.0 and select any granularity that you want for each component.

Real User Monitor
RUM Text Pattern events are not functional for Oracle NCA over TCP (QCCR1I54373)

Description: RUM Text Pattern events are not functional for Oracle NCA over TCP.

Workaround: None.

After upgrading to RUM 9.1x some locations are not supported (QCCR1I61975)

Description: The following locations are not supported by Real User Monitor, and traffic monitored
from these locations is reported with an unknown location:

l Congo The Democratic Republic Of

l United States Minor Outlying Islands

l Macedonia The Former Yugoslav Republic Of

l South Georgia And The South Sandwich Islands

l Korea Democratic People's Republic Of

Workaround:None.

Some active filters do not work on upgraded RUM data (QCCR1I62276)

Description:When reports are generated for RUM data that has been upgraded to version 9.x,
some of the active filters in the report do not work.

Workaround: None.
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RUM reports not available (QCCR1I63076)

Description:RUM reports are not available in BSM.

Workaround: If you configure an application for RUM the first time you log in to a new BSM
system, log out of BSM and log in again before accessing RUM reports.

System Availability Management and
SiteScope

SiteScope Release Notes:Refer to the SiteScope release notes for all SiteScope limitations.

SiteScope Documentation: SiteScope documentation is available only as a standalone help
system. It is not a part of BSM Help.

SAM Administration Copy and Paste: In System Availability Management Administration, when
copying objects from one SiteScope to another, there is no dependency check. This means that
you can copy an object that depends on another object to a different SiteScope, even though the
object on which it depends does not exist on the target SiteScope.

SAM Administration Page cannot be displayed error: In System Availability Management
Administration, when the SiteScope service is down, instead of receiving an error to this effect, you
will see aPage cannot be displayed error.

SiteScope Reset: If a SiteScope is being reset when BSM is not running, the SiteScope will
appear as registered with a configurable profile in System Availability Management Administration
once BSM is running again. The SiteScopemust be reset when BSM is running.

SAM Administration Recently Used Monitors:On theNew Monitor page, theRecently Used
Monitors list is not saved when you exit System Availability Management Administration.

SiteScope Profiles:When creating a SiteScope profile in System Availability Management
Administration, if you change the profile display name after having received any error during the
profile creation process, the default profile name is not changed accordingly. Ensure that the profile
name and SiteScope agent machine location fields contain the desired values.

Monitor Deployment Wizard only supports topology reporting for monitors that have a
default topology defined (QCCR1I39697)
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Description: TheMonitor Deployment Wizard only supports topology reporting for monitors that
have a default topology defined. This means you can select to add a template to a CI only if the CI
type is the default CI type for all themonitors in the template.

Workaround: None.

After an upgrade to BSM 9.20, manually resynchronize SiteScope (QCCR1I39744)

Description: If you upgrade to BSM 9.20 while using SiteScope 11.x, you shouldmanually
resynchronize SiteScope instead of waiting for topology data to be sent to BSM based on the
Topology resynchronization time interval.

Workaround: None.

After Jboss Application Server recovery, there is no data in SAM Administration
"Summary" (QCCR1I44570)

Description: After JBoss Application Server recovers from a server crash, the information in the
right pane of the Summary tab in SAM Administration does not show any data until BSM is
restarted.

Workaround: Restart BSM.

408 Request Timeout error in Internet Explorer 7

Description:When accessing SiteScope from System Availability Management Administration
using Internet Explorer 7, a 408 Request Timeout error is displayed.

Workaround: Configure the browser to accept cookies from the SiteScope server.

1. In Internet Explorer, select Tools > Internet Options > Privacy tab > Advanced button.

2. Select Override automatic cookie handling, make sure First-party cookies and Third-
party cookies are set toAccept, and select Always allow session cookies.

Settings when registering SiteScope to a BSM server that uses a load balancer
(QCCR1I56354)

Description:When registering SiteScope to a BSM server that uses a load balancer, make sure
that the Gateway server name/IP address (in Admin > System Availability Management >
Distributed Settings) is the Default Virtual Server for Application Users URL (and not the Default
Virtual Server for Data Collectors URL). This URL can be found in Admin > Platform > Setup and
Maintenance > Infrastructure Settings > Foundations > Platform Administration > Host
Configuration table.

Workaround: None.
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No reconciliation between SiteScope and Discovery and Dependency Mapping
(QCCR1I56709)

Description: There is no reconciliation between SiteScope and Discovery and Dependency
Mapping when there is only a default SQL server instance. SiteScope reports the default value
"SQLServer" as the name of the CI, while DDM reports the name of the host.

Workaround: Install an SQL database with a named instance.

Unable to perform some actions in SAM Administration in a load balancing environment
(QCCR1I58582)

Description: Unable to perform the following actions in SAM Administration in a load balancing
environment when SiteScope 10.x or later is integrated with BAC/BSM:

l Copy/paste from one SiteScope to another.

l Perform aGlobal Search and Replace.

l Run theMonitor Deployment Wizard.

Workaround: Register (or remove and reregister) SiteScope to the BSM server using the Default
Virtual Server for Application Users URL instead of the Default Virtual Server for Data Collectors
URL (enter the URL in Admin > System Availability Management > Distributed Settings > Gateway
server name/IP address). This URL can be found in Admin > Platform > Setup andMaintenance >
Infrastructure Settings > Foundations > Platform Administration > Host Configuration table.

If you cannot remove SiteScope from BSM because you do not want to lose data, you can change
the host name on SiteScope under BSM Integration Preferences (Preferences > Integration
Preferences > Business ServiceManagement machine name/IP address).

Issue with Operations Manager integration when BSM using an HTTPS reverse proxy or a
load balancer (QCCR1I59226)

Description: If BSM is using an HTTPS reverse proxy or a load balancer, you need to provide the
HP Operations Agent on the SiteScope server with a certificate so that it can communicate
securely with BSM.

Workaround:Check for an updated version of these release notes on the HP Software Support
Site for details on how tomanually configure the agent.

SISConfigurationEnrichmentUpgrader failure (QCCR1I65694)

Description:During BSM upgrade, SISConfigurationEnrichmentUpgrader may report FAILED,
PARTIALLY FAILED, or NOT REQUIRED status, or the BSM content packs may not
automatically upload.

Workaround: Delete the blockAutoUpload file located in the <HPBSM root
directory>\conf\opr\content folder.

Generating SAM Reports (QCCR1I62712)
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Description:When generating SAM reports on a loaded system:

l It takes a couple of minutes for result data to be displayed in the Group Performance Report and
Monitor Performance Report.

l The Cross-Performance Report may not respond when using the Select Measurements filter on
an Internet Explorer browser.

Workaround:Wait until the servers list is loaded in the user interface before navigating to other
profiles.

Transaction Management
Note: For additional release information on TransactionVision components, see the
TransactionVision 9.20 Release Notes, available from the HP Software Support Product
Manuals site.

Java Plug-in Version: TransactionManagement Administration pages may fail to initialize.

In some cases, the Admin > TransactionManagement pages may not initialize. Errors such as the
following appear:

java.lang.RuntimeException:
java.lang.reflect.InvocationTargetException

at sun.plugin2.applet.Plugin2ClassLoader.defineClassHelper(Unknown
Source)

at sun.plugin2.applet.Plugin2ClassLoader.access$100(Unknown Source)

......

Caused by: java.lang.NullPointerException

  at com.sun.deploy.security.CPCallbackHandler.isAuthenticated(Unknown
Source)

These errors are related to the Java Plug-in that is being used to view applets.  See
http://bugs.sun.com/view_bug.do?bug_id=6967414.

To workaround this problem, use Version 6 Update 18 or greater of the Java Plug-in. See the BSM
Deployment Guide for information about the supported versions of the Java Plug-in.

Transaction Management > Administration page does not refresh correctly (QCCR1I47950)

Description: In rare cases, the TransactionManagement > Administration page does not refresh
correctly after some action and the following error appears:
com.hp.am.bac.tvb.admin.shared.TVAdminException: An internal error occurred.

HP Business ServiceManagement (9.20)Page 34 of 58

Release Notes
Notes and Limitations

http://bugs.sun.com/view_bug.do?bug_id=6967414
http://bugs.sun.com/view_bug.do?bug_id=6967414
http://bugs.sun.com/view_bug.do?bug_id=6967414


Workaround: Navigate away from the TransactionManagement Admin UI page (by going to the
site map or some other page), then return to it. The page should be correctly populated.

Error appears when accessing the Administration page (QCCR1I50435)

Description: The following error sometimes appears when accessing the Transaction
Management > Administration page: Unable to communicate with BSM.

Workaround: Log out of BSM and log back in, and then access the TransactionManagement
Administration page again.

Changes to the PresentationQuery.xml file are not reflected until reload (QCCR1I62483)

Description: Changes to thePresentationQuery.xml file in the TransactionManagement Admin
user interface (Admin > Transaction Management > Configuration > TransactionVision folder
> Configuration tab > General tab) are not reflected until the TransactionManagement Admin user
interface has been reloaded.

Workaround: None.

If the Analyzer logging configuration is set to allow very large log files, the log viewer in
the Transaction Management Admin user interface may display incorrectly (QCCR1I64232)

Description: If the Analyzer logging configuration is set to allow very large log files (above the
default values), the log viewer in the TransactionManagement Admin user interfacemay display all
but the last two lines of the log file.

Workaround: The files may be viewed in their entirety on the Analyzer system.

Business Process Insight
The following are the recommended limits to ensure optimum performance, that apply to modeling
and tracking business processes using BPI:

l Maximum number of business process activities per business process model is 50

l Maximum number of unique business process models per BPI deployment is 8

l Maximum number of BPI monitors (amongst all business process models) is 20

l Maximum number of events (amongst all processes per BPI deployment) is 200/sec.

l Maximum number of business process instances stored (amongst all processes per BPI
deployment) is 500,000.

Events from TransactionVision: If you start Business Process Insight while TransactionVision’s
JMS Event Queue services for sending events to Business Process Insight are unavailable, or if
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the JMS Event Queue services become unavailable once Business Process Insight has started,
the OVBPIJmsEventHandler Service stops. To solve this problem, you need to configure the
Windows Service for the OVBPIJmsEventHandler Service underControl Panel >
Administrative Tools > Services. You should configure the service in the sameway as is
described for adapterWindows Services in the Integration Training Guide - Business Events, by
selecting the Recovery option and setting each of the First, Second and Subsequent Failures to the
value of Restart the Service.

Modifying Servlet Engine Files: If you intend tomodify the Servlet Engine (Tomcat) configuration
files, you need to be aware that changes made directly to the Servlet Engine files are overwritten by
Business Process Insight configuration files. Refer to the Business Process Insight Server
Administration Guide for more details.

Missing Infrastructure Settings: If you see an error indicating that one or more Business Process
Insight Infrastructure settings is missing, make sure that you have specified a value for the
Microsoft SQL Server database name:

Instance Database Settings: Database Name

You need to provide a value for this setting even if you are configuring the settings for an Oracle
database. It can be any string, but you cannot leave the field blank; if you do, you receive an error
when accessing the Business Process Insight Application pages.

Servlet Engine Appears Not to Start:Very occasionally, following a system restart, the Servlet
Engine appears not to have started, both within the Business Process Insight Administration
Console and as aWindows Service. The Servlet Engine service is actually in the processes of
starting, but is taking a long time, possibly due to other applications causing delay; for example, the
database can take a long time to start when it is very full.

If you think that you are experiencing this problem:

1. Click theStart button for the Servlet Engine from the Status screen on the Administration
Console.

2. Click theStop button for the Servlet Engine as soon as it is enabled.

3. Your Servlet Engine services are now synchronized and the Servlet Engine is not started.

4. Restart the Servlet Engine as normal.

Unable to Contact RMI Registry During Component Startup: If you receive an error message
indicating that the Business Process Insight Server is unable to contact the RMI Registry on port
44,000, this is likely to be due to a port number clash.

The Business Process Insight RMI Registry uses port 44,000, and if another application or service
is temporarily using this port, then the RMI Registry cannot start. To resolve this problem, you can:
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l wait and attempt to restart the Business Process Insight components again.

l use the Business Process Insight Administration Console tomodify the port number for the
RMI.

Select the Port Numbers tab from the Business Process Insight Server Administration Console to
change the RMI Registry port number from 44,000. If you change the value for the port number, you
need tomake sure that any other configuration affected by this change is alsomodified, for
example, the Business Process Insight Infrastructure settings.

Process Definition Cannot Be Progressed:Process fails to progress when common data and
event definitions are derived from a single process.

The following scenario results in a Process definition that cannot be progressed:

l Create and deploy two Process definitions, each linked to the sameData definition.

l Separate the Processes completely by creating a new Data definition with identical properties to
the first Data definition.

One of the Process definitions is now linked to the newly created Data definition and no changes
aremade to the progression rules. In this case, the Business Process Insight Modeler should
detect that the progression rules are referencing a different Data definition, but it does not and as a
result, no process instances are created.

To resolve this problem, use the Export and Import options within the Business Process Insight
Modeler to make a copy of a Process definition. Use the option to rename the definitions (not
overwrite them).

See “How toManage the BPI Modeler” in the Using Business Process Insight guide for details of
making copies of your Process definitions.

Empty String Values and Null String Value Evaluation in Oracle: When entering property
values for subscriptions within the Business Process Insight Modeler, be aware that the Oracle
Server does not distinguish between a zero-length string, and a string with a value that has not been
assigned (null string). This means that if you want to test a zero length string within a subscription,
you are advised to use a single blank space (“ “), and not an empty string (““).

Error Importing a Process Definition: If you see an error message similar to the following when
importing a Process definition into the Business Process Insight Modeler, it is possible that you are
attempting to import a Process definition with a name that contains characters that are locale-
specific:

The file proc-defn-name.zip is not a valid import file. Please see the log file for more
information.

where proc-defn-name is the filename, based on the Process definition name.

There are restrictions in the use of locale-specific character sets, whereby a .zip file name can
contain characters only from the character set of the system locale where the Business Process
Insight Modeler is running. The content of the file can contain any characters, but the file name is
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limited by the character set of theWindows system that is reading or writing the file. In the case of
the zip archive files for exporting and importing processes, the zip archive file name is based on the
Process definition name. Therefore, if you want to export a Process definition, you have to consider
where you will be importing the file. If you plan tomove the file across locales, you are advised to
use only ASCII characters for the Process definition name to ensure the file can be read on any
configured locale.

This problem can also occur if you change the locale of theWindows system where you have
created the Process definitions.

Changing the Locale: If youmodify the locale for a system where the Business Process Insight
Server is installed, youmight find that you cannot start the Business Process Insight
Administration Console when you reboot your system. The Administration Console also returns an
error indicating that it cannot find themain class and that the program will exit.

This can happen in cases where Business Process Insight is installed into a directory, which is
named using locale-specific characters. If the locale for the system is then changed, it is not
always possible for the directory and file names to be readable using the character set of the new
locale.

If you have changed the locale of the system where Business Process Insight is installed and you
are experiencing this problem, you need to:

l revert to the original locale and continue to use Business Process Insight.

l revert to the original locale, uninstall Business Process Insight, configure the new locale, and
then reinstall Business Process Insight into a new directory.

Installation on Turkish Locale Causes an Exception: If you attempt to run the Business
Process Insight Installation procedure using a Turkish locale, the installer does not present the
installation screens correctly and, as a result, you cannot answer the installation questions. This is
a problem related to the installation software.

In order to complete the installation successfully, you need to temporarily set the locale to a United
States locale. When you have completed the installation, you can reset the locale to Turkish.

Non-ASCII characters in the Oracle Database Data Directory: If you enter non-ASCII
characters for the Oracle database data directory during the Business Process Insight installation,
the installation fails with a Database Setup error. The error indicates that Oracle is unable to create
the database instance or a database table.

If the Business Process Insight installer reports a Database Setup Error, and you have used non-
ASCII characters for the name of the database data directory, you need to reinstall (overinstall)
Business Process Insight into the same location, this time using a database data directory name
that contains only ASCII characters.

Microsoft SQL Server 2005 Excessive Checkpoint Process I/O: If you are usingMicrosoft
SQL Server 2005 and you are aware that you are having problems with database checkpoint I/O
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requests, you are experiencing a known problem with SQL Server 2005. The problem has been
fixed by Microsoft and has the followingMicrosoft defect number: 50000708.

Microsoft provided a solution for this problem in their Service Pack 2 for SQL Server 2005. You
need tomake sure that you have installed Service Pack 2. Microsoft also recommends that you use
the -k3 startup parameter to limit the I/O requests generated by the checkpoint process. Refer the
defect text provided by Microsoft, or theMicrosoft documentation for details of using startup
parameters.

InstallAnywhere Uninstaller Stops Responding:Many errors encountered when the
InstallAnywhere uninstaller is running, for example, amissing JVM, causes the uninstaller to stop
responding, or hang.

If you experience a problem where the Business Process Insight uninstaller stops responding, you
need to complete the following tasks according to what you have installed:

1. Stop the uninstaller process, which is still running on your system. For example, on aWindows
system use the Task Manager.

2. If you are removing a Business Process Insight Server, delete the Business Process Insight
files under the Business Process Insight installation directory.

3. Modify the ZerogGlobal Registry (an InstallAnywhere file):

n Open the registry file, which is usually located in c:\Program Files\Zero G
Registry\.com.zerog.registry.xml. Note that onWindows the registry file is
located in a hidden directory, so youmight have to configure your system to display hidden
directories and files.

If the registry file contains only entries for the product that you are attempting to uninstall,
you can rename the file. However, if there aremultiple product installations, or multiple
instances of one product installation, you need to edit the file as described in the following
step.

If the registry file contains entries in addition to those for Business Process Insight, edit the
file to remove the following entries:

n The product elements for Business Process Insight. Make sure the element references the
directory where the files are located that you want to uninstall.

n The components elements for Business Process Insight. Make sure the component
element references the directory where the files are located that you want to uninstall.

Precision of Monitor Instance Values (QCCR1I28156)

Description: The processing and display of Business Process Insight monitor instance values is
only done to a precision of 6 or 7 digits, and not to the precision of 15 digits used for process values.
This canmean that large integer values may not show their exact value. For example, $123,000,
000 could show as $123,000,064.

Workaround:None.
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Landing pages not displaying monitor values and statistics to double precision
(QCCR1I29319)

Description:Business Process Insight Landing pages are not displayingmonitor values and
statistics to double precision.

Workaround:None.

Instance pages fail (QCCR1I30664)

Description:Business Process Insight instance pages fail when first accessed in amulti-domain
LWSSO configuration.

Workaround:Access theProcess Repository Explorer under the Business Process Insight
Admin area in Business ServiceManagement (Admin->Business Process Insight->Process
Repository Explorer). After doing this, the process instance pages can be accessed normally.

Monitors with a type of Absolute Duration raise violations before an instance has
completed. (QCCR1I31705)

Description:Unlike other monitors, those with a type of Absolute Duration raise violations before
an instance has completed. When there is a combination of a short absolute threshold duration and
the event which completes the instance is constantly delayed, violations are incorrectly raised for
every instance. For example, a combination of a critical threshold of 30 seconds and a latency of
fiveminutes for the end events causes a violation.

Workaround:Disable the violation detection for instance durationmonitors that have yet to
complete. This is achieved by altering the relevant stored procedures (METRIC_THRESH_
ACTIV_INSTS_OVER andMETRIC_THRESH_ACTIVE_OVERDUE) to not match on active
instances:

l ForMS SQL, this can be done by doing the following:

a. RunMicrosoft SQL Server Management Studio (or equivalent).

b. Connect to the BPI Instance database (default is hpbpischema).

c. Navigate to the Stored Procedures (for example, Programmability > Stored Procedures).

d. Select the stored procedure calledMETRIC_THRESH_ACTIV_INSTS_OVER.

e. Select Modify (or equivalent) to modify the stored procedure.

f. Replace Active with Never in the stored procedure.

g. Click Execute on the toolbar (or equivalent) to apply the change.

l For Oracle, this can be done by doing the following:

a. RunOracle EnterpriseManager (or equivalent) and connect to the BPI Instance database.

b. Navigate to the Stored Procedures section (for example, Administration >Procedures) and
display the list of stored procedures for the BPI schema.

c. Select the stored procedure calledMETRIC_THRESH_ACTIV_INSTS_OVER.
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d. Select Edit (or equivalent) to modify the stored procedure.

e. Replace Active with Never in the stored procedure.

f. Click Apply (or equivalent) to apply the change.

Note: The caveat to the above workaround is that if there are process instances experiencing
issues, the absolute duration violations will not be triggered until after themonitor scope for
the process instances is complete. Therefore, the absolute duration violations may not be
triggered if the active process instances are blocked on a particular Activity within the
Business Monitor span and none complete themonitor scope. This workaround should only
be used if the implications of this are acceptable.

BPI does not support Oracle 11g RAC (QCCR1I33021)

Description: BPI does not support Oracle 11g RAC.

Workaround: None.

Business Process Diagram context menus intermittently shows JavaScript errors
(QCCR1I34412)

Description: Context menus within Business Process Diagram intermittently show JavaScript
errors.

Workaround: Close all open browsers and reopen the BSM user interface.

List of monitors in the Business Health tab on the BPI Health page includes default non-
grouped monitors (QCCR1I35229)

Description: On theBPI Health page, when you specify a non-default process grouping (other
thanAll), the list in theBusiness Health tab at the bottom of theBPI Health page includes both
the Business Process Monitors that match the grouping criteria and the Business Process Monitors
that have no Process Definition Group Property specified.

Workaround: If you want to segregate all Business Process Monitors by groups, then designate a
group value for each of the Business Process Monitors when you create or update the Business
Process Monitors in theMonitor Definer.

Monitor Definer landing page does not show the data collected for the State group
(QCCR1I35230)

Description: If a Business Process is deployed with a Group property (such as Region) and a
Business Process Monitor is defined with a different Group property (such as State) then the
Monitor Definer landing page will not show the data collected for theState group.

Workaround: Define the sameGroup property for both the Business Process and Business
Process Monitor to see the group breakdown in the landing pages.
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Deadline thresholds for Business Process monitors cannot be calculated
(QCCR1I38172/QCCR1I38173)

Description:Deadline thresholds for Business Process monitors cannot be calculated if the name
of the deadline property has greater than ten characters and the BPI Instance Database is on an
Oracle server. 

An error can occur when calculating the deadline or status for deadline thresholds on Business
Process monitors if the BPI Instance Database is on anOracle server.  This error appears in one of
two ways:

l The value of the deadline is listed as Deadline unavailable, while the following warning
message appears in theMonitor Engine log:

WARNING: Monitor generation failed for… ORA-00972: identifier is too long: …

l Themonitor status is listed as No monitor information recorded for process instance, while
the following warningmessage appears in theMonitor Engine log:

WARNING: Monitor generation failed for… ORA-00904: … invalid identifier…

Workaround: Change the name of the deadline property to 10 or fewer characters.

Security warnings when launching the BPI Modeler (QCCR1I38624)

Description:When launching the BPI Modeler, youmay see any of the following security warning
messages:

l The application's digital signature cannot be verified.

l Part of the application is missing a digital signature. Only run if you trust the origin of the
application.

l And after clicking onMore Information,
Although the application has a digital signature, the application's associated file (JNLP) does not
have one.

Workaround: Themessages can safely be ignored.

KPIs that contain multiple related Health Indicators are not shown in the Business Health
tab in the Health page (QCCR1I38672)

Description: The Business Health tab in the Health page displays a gauge for all KPIs that have
configured objectives. Any KPIs that contain multiple related Health Indicators, however, will not be
displayed.

Workaround: Create a unique KPI for each Health Indicator.

Instance violation counts are always zero on the Health page (QCCR1I39397)
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Description: The Business Health tab in the lower-right pane of the BPI Health page shows how
many BPI monitor threshold violations there have been within themost recent sample period. The
sample period corresponds to the period at which data samples are sent to BSM. If the sample
period is too short, or the clocks are not synchronized between the database and BPI Server hosts,
the violation counts may always be zero.

Workaround: If the violation counts on the BPI Health page remain zero when you expect there to
be violations, check the following:

l Ensure the clocks are synchronized on the host systems for the database server, BPI server,
and BSM.

l Increase the Data samples send interval option on the HP Business ServiceManagement
settings page of the BPI Server Administration Console.

Errors with long names for the BPI Instance database and user name (QCCR1I41558)

Description:When installing the BPI server onMSSQL (2008), multiple errors will occur if you
have a large BPI Instance database name and large user name.

Workaround: Use up to amaximum of 16 characters for the BPI Instance database name and the
user name.

Errors may occur if a non-admin Oracle user attempts to install a BPI instance
databasewith tablespace names that already exist in Oracle DB (QCCR1I42012)

Description:When installing the BPI instance database on anOracle database where pre-existing
BPI tables exist (from a previous BPI installation where the Keep BPI data option was selected
during the previous version uninstall), errors may occur if the database setup is conducted by a non-
admin Oracle database user.

Workaround:When installing BPI against an Oracle database where legacy BPI database data
has been retained from a previous installation, perform the BPI Instance database setup on the
Oracle database as the Admin Oracle database user.

When deleting a previously created Data definition in BPI Lite mode an error may occur
(QCCR1I45844)

Description:When using theModeler in BPI Lite mode (BPI is not licensed or the BPI Server is not
running), and you delete an existing Data definition that was created for a Business Process in BPI
Full mode, an error may occur. 

Workaround: Re-create a Business Process model with no Data definitions.

Filter Validation Error in the Monitor Over Time report (QCCR1I47399)

Description: In theMonitor Over Time report, a Filter Validation Error occurs if you did the
following: 1) opened theMonitor Over Time report immediately before you created amonitor, 2)
navigated directly toBPI > Admin > Monitor Definer and added amonitor, and 3) navigated back
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to BPI Applications through the applicationmenuApplication > Business Process Insight,
which reopens theMonitor Over Time report and the Filter Validation error.

Workaround: If you go out of theMonitor Over Time report by navigating to another report, or to the
site map, and then reopen theMonitor Over Time report, the error is resolved.

Process Definition Name and the Data Definition Name cannot be identical (QCCR1I48053)

Description:When creating a Business Process Model in theModeler, the Process Definition
Name and the Data Definition Name cannot be identical. Be sure that the Data Definition Name
string is different from the Process Definition Name for all Business Processes.

Workaround: Change the Data Definition Name using theModeler if necessary.

BPI Value monitors show the completed process value instead of the value of the activities
in the span (QCCR1I48691)

Description: If you create a BPI Valuemonitor that spans multiple activities, and the value does
not change from one activity to another, themonitor reports the value for the last activity in the
span. However, in such cases where the value changes across activities, themonitor reports the
value of the completed process even if the last activity that completes the process is not in the
defined span.

Workaround: None.

Error when using TV-BPI integration and the Decimal column type (QCCR1I50361)

Description:When opening an event definition exported from the TV txn that has a data field of
decimal type, an error occurs.

Workaround:When using TV-BPI integration, do not use the Decimal column type either when
creating a data column in the UI or when creating XDM definitions by hand through XML. Use
Double instead of Decimal.

Selecting the PDF menu item in the Scorecard reports does not work for some Business
Processes (QCCR1I56352)

Description:Selecting the PDFmenu item in the Scorecard reports does not work for some
Business Processes andmay display the error message: HTTP 500 error.

Workaround:None.

Modeler occasionally fails to start with error "Unable to use remote proxied object"
(QCCR1I60390)

Description:Occasionally, when the BPI Modeler is launched, an error repeatedly appears that the
Modeler cannot access the process repository. (QCCR1I60390)
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Workaround: Follow these steps to resolve this issue if it persists. Youmust have BSM
Administrator permissions.

1. Ensure the process repository service is up and running.

a. Launch theHP Business Service Management Status panel on the BSM host.

o ForWindows, access: Start > All Programs > HP Business Service Management
> Administration > HP Business Service Management Status.

o For Linux, access: http://<BSM_FullyQualifiedHostName>:11021/
invoke?operation=showServiceInfoAsHTML&objectname=
Foundations:type%3DNannyManager

b. After you launch the Status panel and log in, look for aServiceName called bpi_process_
repos.

c. Verify that the bpi_process_reposStatus is STARTED. If not, youmay need to restart
BSM.

d. If you have a full BPI installation with a licensed server, ensure that all the BPI components
are running on the BPI Administration Console Status page.

2. Ensure your browser has the appropriate proxy configuration.

Access the Proxy settings dialog to see if the BSM domain has a proxy exception in the proxy
exceptions list. For example, if your BSM server is called bsm.hp.com, then the proxy
exception would be *.hp.com. Internet Explorer calls these proxy Exceptions, and Firefox
calls theseNo Proxy for. If there is no BSM domain proxy exception, and it is appropriate, add
the BSM domain to the exceptions list.

Accessing the Proxy Settings panel varies depending on the type of browser and browser
version you use to access BSM. Usually, the proxy settings can be configured from the
browser tools or options panels in the network configuration or LAN settings under proxy
servers.

3. Clear javaws cache.

Typically, the bpimodeler.jnlp file in javaws cache is updated when changes are detected,
but by manually uninstalling the application from javaws, you ensure a fresh download of the
bpimodeler.jnlp from the BSM server. On the system where you plan to launch themodeler,
run javaws –uninstall in a command prompt.

4. Clear the browser cache of BSM cookies.

Your browser cachemay contain a stale BSM cookie, which does not have the correct session
ID and/or proper credential information. This can occur during unusual BSM shutdown
scenarios where theModeler was running at the time of the BSM shutdown.

Clearing the cache specifically for BSM is different depending on which browser you are using:

n Firefox Browser

i. Select the Tools > Options > Privacy tab.

ii. On the Privacy tab, click on the remove individual cookies link. A dialog opens with
a list of cookie sites.

iii. Search through the sites for the hostname of your BSM host and select it.
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iv. Click theRemove Cookie button at the bottom to remove the cookies associated with
the BSM host site and close all Tools windows.

n Internet Explorer Browser

The following procedure ensures proper deletion of the targeted cookies, rather than using
the Internet Explorer cookie removal tool, whichmay not always permit file deletions.

i. Select the Tools > Internet Options > General tab.

ii. Click theSettings button for deleting temporary files, history, cookies, and so on. A
Settings dialog opens.

iii. Click the view files button to view the cookies, which are opened in aWindows
Explorer window to your local Temporary Internet Files location.

iv. Open a secondWindows Explorer window.

v. Copy and paste the Address line (for example, C:\<Local
Settings>\Temporary Internet Files) from the original Windows Explorer
window opened by the IE browser, to the secondWindows Explorer window.

All the cache files are visible from this second window.

You can now delete any of the IE browser cache files from this secondWindows
Explorer window.

vi. Search for and delete a pair of files called topaz/ (see the adjacent Internet Address
column):

o One file is associated withCookie:<user>@<bsmhost>/topaz/.

o One file is associated with http://<bsmhost>/topaz.

Application Management for SAP
SiteScope SAP CCMS Alert monitor is not displayed (QCCR1I46581)

Description: The data received from the SiteScope SAP CCMS Alert monitor is not displayed in
Service Health and Service Level Management SAP Systems views when working with
ApplicationManagement for SAP application.

Workaround: None.

Run-time Service Model (RTSM)
Installation and Upgrade

When the Data Flow Probe is configured to be installed in separatemode, so that Manager and
Gateway processes are running on separatemachines, the following additional configuration is
required on the Discovery Flow ProbeManager's machine:
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1. The ProbeManager must have the exact same Probe ID (appilog.collectors.probe.name) as
specified during the installation of the ProbeGateway.

2. Stop theManager process (if it is already running).

3. Open <UCMDB installation>\ DataFlowProbe\conf\DiscoveryProbe.properties and
locate the following code:

# The Domain name

appilog.collectors.domain = ${DefaultDomain}

4. Change this code to contain the Data Flow Probe's actual domain. For the default domain,
DefaultDomain, this code should look as follows:

# The Domain name

appilog.collectors.domain = DefaultDomain

5. Save DiscoveryProbe.properties and start theManager process.

After upgrading to RTSM 9.05, if a job's time zone setting was other than "Discovery probe time
zone", it must be reconfigured to the correct time zone.

When upgrading from previous versions of RTSM, if you enabled Update/View permissions in the
Data Flow Management modules, but did not enable the Execute permission, youmust manually
re-enable thosemodules by selecting the Execute/Update permission for the relevant users. For
the Adapter Management, the permission should be set toUpdate.

Before installing a Content Pack, make sure that RTSM is running and that you run the JMX
operation, adjustFactoryClassModel, to align the class model. The adjustFactoryClassModel
operation can be found with the Class Model Services. This operation aligns the factory flag for all
classes and all class properties (such as attributes, qualifiers, and so on).

If integrations are configured in the RTSM Integration Studio (for example, topology synchronization
integrations between central UCMDB and RTSM), after upgrading, the Data Flow Probe will run
population jobs immediately for active integration points, even if the integration is not scheduled. If
you do not want the integration to run, disable the integration before running the upgrade from any
BSM 9.x version.

When upgrading from BAC 8.0x to BSM 9.20/RTSM 9.05, the following limitations apply:

l Generic BreakdownReports with four breakdown criteria will lose the fourth criteria. Only three
breakdown criteria are supported in version BSM 9.20/RTSM 9.05.

l RTSM 8.x annotated reports are no longer supported in version BSM 9.20/RTSM 9.05. They will
be lost upon upgrade.
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If the root CIT configured in UCMDB before the upgrade from BAC 8.0x was IT_World, the value of
it after the upgrade is ManagedObject.

Application and Modeling
The UCMDB server may not start up properly when the settingMax CIs in view supported to
rediscover in the Infrastructure Settings Manager is set to very high values.

When creating a cron expression in the Job Definition Scheduler, the time and datemust be in the
future. If the current date or a past date is defined, it will cause an error.

When Delete permission is assigned for a CIT, all of its sub-classes can also be deleted.

When Create permission is assigned for a CIT, it can be updated and all of its sub-classes can also
be created.

In Enrichment Manager, Impact Analysis Manager, and CIT Manager, when you select several
CITs and their connecting relationships and select Export Map to Imagewith theSelected Object
Only option, the resulting image does not display the relationship names.

It is possible to edit CITs even if they are assigned the READ_ONLY_CLASS qualifier.

The Screen Capture tool cannot capture a screen shot when the UCMDB/RTSM browser is running
in amulti-display environment.

TheClear Filter button in the Job List dialog box (for scheduled reports and scheduled snapshots)
does not work properly.

When creating a new Impact rule in the Impact Analysis Manager, the created Impact rule can be
run within the IT UniverseManager even if theUCMDB check box on the Impact Rule Groups page
of the wizard is not selected.

In IT Universe, if you right click a Virtual Compound Link from theGet Related pane, the Show
Compound Path option is disabled.

HP Business ServiceManagement (9.20)Page 48 of 58

Release Notes
Notes and Limitations



The following API has been added to the CI Selector to get the selected CIs' display labels and
class names using Javascript:

l String getSelectedCmdbObjectDisplayNames()
l String getSelectedCmdbObjectClassNames()

The new retrieveAllActiveUsers()method is now available in theUCMDB-UI:name=UCMDB
Integration section of the JMX console. This is equivalent to the getAllActiveUsers()method that
was available in UCMDB version 8.0x.

In the UCMDB_JavaAPI, in cases where an attribute type was of type string or integer list, the
Attribute#getDefaultValue()method, which had returned strings in XML format, now returns a
collection of string or integer objects.

There have been some performance improvements in the Generic Database Adapter.

In theViews tab in the Security Manager, when Delete permission is set and a view is deleted, the
query on which the view depends is also deleted.

When working in multi-customer environment (such as SaaS), youmust work with a single
database and schema.

In theModeling Studio, it is not possible to createmore than one pattern-basedmodel of the same
CI type, based on the same query. When you try to create a new one, it overwrites the existing one.

Deprecated CI types do not appear in strike through font if the font size is less than 14 points.

In the Routing tab in the Layout Properties dialog box, (accessed by selecting Layout > Layout
Properties), all the options seem to be available, but only some of them are actually used in the
layout of themap.

In the Impact Analysis Manager, if an XML file is imported with the same file name as an existing
Impact Rule, a confirmationmessage saying that an Impact Rule of that name already exists is not
displayed before replacing the existing Impact rule.
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When exporting CI instances found for a selected TQL, you can now manually enter up to 150,000
CIs per page.

If you haveDelete permissions for views and you delete a view, the TQL query on which the view
depends is also deleted.

In theModeling Studio, no informative error message is displayed when you import an invalid XML
file for views or queries.

In Modeling Studio, you cannot change the query type of an Enrichment or Impact Analysis query in
the Query Definition Properties dialog box if there are resources that are defined on top of this
query.

In the Impact Analysis manager, when you try to save an Impact rule for which you defined a sub-
graph, a generic error message appears without giving detailed information regarding the problem.

Printing semi-transparent graphics using theRun Screen Capture Tool produces poor quality
results.

In the Hierarchical tab in the Layout Properties dialog box, (accessed by selecting Layout >
Layout Properties), theMinimum Backward Edges andOptimize For Feedback Flow options
do not work properly.

The new viewing system currently does not support displaying view results via the IT Universe
Manager that were based on a rule-based template.

When displaying CIT instances with the network port number property, the network port number is
displayed with a comma. This comma is irrelevant but is displayed because of themanner in which
Java reads the value from the system.

When you search for a string in theModeling Studio or the Reports module, the Highlight button
highlights only the first occurrence of the string that is found.

When a calculated relationship is selected in Enrichment Manager or Impact Analysis Manager, the
Qualifier tab in the Relationship Properties dialog box is not functional (the qualifiers selected are
not applied to the selected relationship).
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When creating a view based on a new TQL query in Modeling Studio, if you add a condition to one of
the query nodes and save the view, and thenmodify the view topology without closing the window,
an error is generated. To avoid the error, close the window after adding the condition and saving the
view, and then open the view again andmake the topology changes.

The Show Element Instances dialog box does not display the External icon for federated CIs.

The Hierarchy Pane of the Pattern View Editor in Modeling Studio does not display the External
icon for federated CITs in the TQL query.

When editing an out-of-the-box attribute of type byte, an error is generated. For example, when
editing the AttachementContent attribute of an Attachment CI, an error occurs. User-created
attributes can be edited safely.

You can set the starting date and time and repeat interval for pattern-basedmodel updates using the
Pattern BasedModel Scheduler dialog box in theModeling Studio. Select Daily Pattern Based
Model Scheduler Updates to set the repeat interval in hours. Select Advanced Pattern BasedModel
Scheduler Updates to set the repeat interval using a Cron expression.

Reports
To enable hyperlinks in reports, set the infrastructure settingEnable links in exported reports to
TRUE. To display icons in exported reports, set the infrastructure settingDisplay icons in
exported reports to TRUE.

When you open the Compare Snapshots Report from IT UniverseManager, theSend Mail,
Generate Direct Link, andExport Report buttons are enabled before a report is generated. If you
click them, they have no effect.

Confidential Manager
If you change the default domain name in RTSM, youmust first verify that the Data Flow Probe is
not running. After the default domain name is applied, youmust execute the
DataFlowProbe\tools\clearProbeData.bat script on the Data Flow Probe side, and then restart
the Data Flow Probe.

Note:Execution of the clearProbeData.bat script will cause a discovery cycle on the Probe side
once the Probe is up.
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Discovery
When setting up the Data Flow Probe, if you import illegal ranges from aCSV file (for example, the
start IP is higher than the end IP), no error is displayed, and the range is saved. Youmust fix the
invalid rangemanually.

SQL Protocol: The EncryptionMethod field enables you to choose SSL support for Oracle
connections.

SNMP Protocol: ThePrivacy Algorithm now supports both DES and AES algorithms.

If you want to connect a new Data Flow Probe to UCMDB/RTSM with an identifier of a Data Flow
Probe that is already defined on a different domain, youmust remove the existing Probe from
UCMDB/RTSM (from the Data Flow Probe Setupmodule), prior to installing the new Probe.

To prevent an overload on the Data Flow Probemachine, you can limit the number of remote
processes that run simultaneously. Locate the
appilog.agent.local.services.maxRemoteProcesses parameter in the
DiscoveryProbe.properties file. The default value is unlimited (-1). Change the value to the
maximum number of processes that can be run simultaneously. If you change this value, youmust
restart the Probe. (This overload can occur when activating certain out-of-the-box jobs that launch a
Java process for each destination, for example, J2EE or SAP jobs.)

Downloaded jar file resources can cause the Probe to restart before all the other resources of an
adapter package have downloaded. To prevent this occurring, the reset time is, by default, 40
minutes. You can change this time:

Access the appilog.agent.probe.restartProbeAfterJarDownload.interval parameter in the
DiscoveryProbe.properties file. The delay until a restart on the first resource download (that is, for
a first start or after clearing the Probe data) is 10milliseconds.

In the Dependency Map, when selecting to show all instances of a selected CI, the instances are
not displayed.

When you try to filter triggered CIs by probe in the Discovery Control Panel - Status pane, the
triggered CIs are not filtered.

Discovery job error and warningmessages are displayed in the language of your client's operating
system, independent of browser language settings.
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Integration
If you are using data synchronization between BSM and the central CMDB (or vice versa) with
aging enabled in the adapter, if you disable the sync for a time period which exceeds the aging
interval, CIs may be deleted by the agingmechanism. As a result, related data and configurations in
BSMmay be lost as well.

Workaround: If you plan to stop data synchronization between BSM and the central CMDB for a
time period which exceeds the aging interval, it is recommended to disable the aging in the adapter.
If the aging has been enabled and is changed to be disabled, it is recommended to run full data
synchronization before stopping the data synchronization between BSM and the central CMDB.
(QCCR1H65590)

When running a history-based push job (for changes), you can incorrectly select any integration
TQL query, even those that are federated or contain virtual links.

If you start a population job (for the first time) on a TQL query that is currently being edited, saving
the query may remove its "Active" status and cause the job to fail. If this occurs, running a full
population job again will fix the problem.

A population job that uses the UCMDB 9.x adapter to retrieve federated data can retrieve only
added or updated CIs, but cannot remove deleted CIs from the CMDB.

The EMC Control Center (ECC) database does not containWWN (WorldWide Name) information
for FCHBAs (Fiber Channel Host Bus Adapters) attached to Storage Arrays. Therefore, this
discovery populates theWWN attribute of FCHBA CIs with the ECC ID (internal to ECC) of the
HBA. The script also populates the data_note attribute of each such FCHBA CI with a note that
ECC does not haveWWN info and duplication of this CI is possible.

Federation
If you set a property condition on a query node that may bring data from external data sources
(federation) and the condition is not supported by one of the data sources, the TQL query calculation
will fail.

Federated nodes incorrectly show suggested values from the local CMDB, even when their only
data sources are external.

If an integration point that supports a CIT that is being queried by the CI Selector in the IT Universe
Manager, and this integration point does not support conditions on the display label, no results are
shown.
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Discovery and Integration Content
Discovery and Integration Content Pack 10.01 is included with BSM 9.20. There is no need to
install it separately. If you installed any later content packs, they will remain intact after installing
BSM 9.20. Later Content Packs can be installed separately after 9.20 is installed. Before installing
any other content pack version, verify that it is compatible with the current version of BSM (see the
relevant Content Pack documentation, or check the SSO site for updated support matrix
information).

Content Pack Documentation Updates

To read the latest versions of the relevant documents, access the following URLs:

l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/DDMContent.jsp – Discovery and
Integration Content Guide

l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/permissions.jsp – the Permissions
document

l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/readme.jsp – the Release Notes (this file)
l <http://SERVER_NAME:PORT/ucmdb-ui>/docs/whatsnew.jsp –What's New in this release

RTSM Multilingual Support
Multi-Byte characters do not appear in titles and sub-titles in reports when exporting or previewing
as PDF.

For reasons of compatibility, Integration Point names and Data Flow Management job names can
include only English letters, numbers, and the underscore character (_).

Because themaximum string length for many UCMDB parameters is defined and documented in
bytes, the real acceptable value length is shorter whenmulti-byte or language-specific characters
are used.

In Enrichment Manager, required attributes in theNode Definition dialog box are not marked in
bold for the Japanese, Chinese, and Korean versions.

Non-English characters should not be used in paths to different properties or adapter files.

Multi-byte characters should not be used in user passwords.

HP Business ServiceManagement (9.20)Page 54 of 58

Release Notes
Notes and Limitations

http://support.openview.hp.com/sc/support_matrices.jsp
http://support.openview.hp.com/sc/support_matrices.jsp
http://support.openview.hp.com/sc/support_matrices.jsp


The action names in scheduled jobs are stored with localized names (according to the locale being
used), but those names are displayed with no dependence on locale. Those action names may be
user-modified and therefore will be user-specific.

Excel can now open UTF-8 encoded CSV documents correctly.

HP Universal CMDB/RTSM does not fully support surrogate pairs and combining characters.

Multilingual Support
BSM/OMi

BSM/SHA Installer is not localized to Spanish (QCCR1H70346)

BSM/SHA Installer does not support Japanese, S-Chinese, Korean, German on Linux
system (due to QCCR1H72432 and QCCR1I73877, these languages are disabled on Linux)

User cannot change currency symbol in SHA (QCCR1I70497)

Items in component gallery are not translated; Service Health top pane tabs (Page Names)
are not localized (QCCR1I69138, QCCR1I45575)

Unreadable characters in command line interface help (QCCR1A139904)

Description: There is a general problem with printing localized unicode text on theWindows
command line. Due to limitations in the default console font and the wrong code page being in
place, certain characters do not display correctly.

A detailed description of this problem can be found at :

http://illegalargumentexception.blogspot.com/2009/04/i18n-unicode-at-
windows-command-prompt.html#charsets_1252

Workaround: In the console window onWindows perform the following actions:

1. Open the properties of the commandwindow (right-click on frame and select Properties.
Switch to the Font tab and change the font to Lucida Console.

2. Click theOK button to close the properties dialog. The new font setting is used for all future
command prompts.

3. In a commandwindow, enter the following command:

chcp 1252

HP Business ServiceManagement (9.20)Page 55 of 58

Release Notes
Notes and Limitations



All command line tools should now display with the correct localized text.

CI Statuses from definitions "Changed from" and "Changed to" are displayed on BSM
Server locale for OMi Event Console (QCCR1I53350)

Find Matching Event window: meaningless characters in the IE 7 title bar in non-English
language sessions (QCCR1A127305)

Application > Service Health top pane tabs (Page Names) are not localized (QCCR1I45575)

To enable MLU support in PDF reports User should specify Unicode font in Infrastructure
Settings Manager > Foundations > Reporting > “Unicode font path for displaying PDF
characters” (QCCR1I21288)

The RTSM Class Model does not support multi-byte character sets. All class model items,
including CI type, relationship, and attribute names, descriptions, and display labels,
cannot contain multi-byte characters. (QCCR1I62755)

RUM
RUM Engine 'Transaction Management Configuration' page UI will be on JVM locale
instead of browser one (QCCR1I57500)

RUM Installer is missing fonts of Chinese/Japanese/Korean on RedHat 6.x
(QCCR1H72432)

RUM Installer does not display Korean characters, shows "empty squares" on Linux
systems (QCCR1H72088)

RUM Installer is not localized to Spanish (QCCR1H70346)

BPI
UI of BPI modeler is displayed as BSM Server OS locale (QCCR1I69767)
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Installation on Turkish Locale Causes an Exception: If you attempt to run the Business
Process Insight Installation procedure using a Turkish locale, the installer does not present the
installation screens correctly and, as a result, you cannot answer the installation questions. This is
a problem related to the installation software.

In order to complete the installation successfully, you need to temporarily set the locale to a United
States locale. When you have completed the installation, you can reset the locale to Turkish.

Non-ASCII characters in the Oracle Database Data Directory: If you enter non-ASCII
characters for the Oracle database data directory during the Business Process Insight installation,
the installation fails with a Database Setup error. The error indicates that Oracle is unable to create
the database instance or a database table.

If the Business Process Insight installer reports a Database Setup Error, and you have used non-
ASCII characters for the name of the database data directory, you need to reinstall (overinstall)
Business Process Insight into the same location, this time using a database data directory name
that contains only ASCII characters.

Diagnostics
The localized Diagnostics_Content_Pack.xml for de, es, fr, ja, ko, ru, and zh_CN
languages will not be in BSM 9.20 packages. As a result, L10N users will see English CI
and KPI names. (QCCR1I75556)

Diagnostics - no support for non-English characters in Java and .NET Probes names
(QCCR1I57918)

SiteScope
SiteScope Installer is not localized to Spanish (QCCR1H70346)

SiteScope Installer is missing fonts of Chinese/Japanese/Korean on RedHat 6.x
(QCCR1H72432)

SiteScope Installer does not display Korean characters, shows "empty squares" on Linux
systems (QCCR1H72088)

Management reports by default do not support UTF-8 encoding. Workaround is to check
International version check box in Preferences > General Preferences. (QCCR1I56586)

HP Business ServiceManagement (9.20)Page 57 of 58

Release Notes
Notes and Limitations



Run results for some monitors are shown according to the server locale or in English,
instead of the client locale (QCCR1I30190)

Localized Service names are not readable while trying to add a Service monitor on WMI
remote host. Workaround – use NetBios. (QCCR1I30808)

For SiteScope versions 11.10 or earlier integrated with OMi – CI names characters and
alert names are not readable in OMi Event console. Workaround is to use same locale as
SiS server OS in the entities’ names (QCCR1I43630)

When using the Microsoft Windows Resources monitor in a non-English locale, the
monitor counters and run status summary are not readable. Workaround: Configure the
monitor to use the Direct registry queries collection method. (QCCR1I54985)
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